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Preface

This preface provides information on the following topics:

• Documentation

• Available Services

• Feedback Forum

Documentation

The documentation for this product includes a help system and PDF 
documentation. 

This topic includes the following information:

• Using the Help System

• PDF Documentation—User Reference and Release Notes

Help System

The help system consists of descriptions and steps for using this product. You 
can access the information you need quickly and easily while working at your 
computer.

You can locate information in the help system using:

• Contents: Browse categories of information organized by topic
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Preface Documentation
• Index: Look up a word in an alphabetical list of key words linked to 
the help system

• Search: Search for any word in the help system

• Steps: Follow these step-by-step procedures for completing tasks

• Dialog Box Descriptions: Review a snapshot and a list of field 
descriptions for any dialog box in the application.

• Glossary: Look up a definition for a term in an alphabetical list

Help system topics in the Contents menu appear in the same order as the menu 
items in the application. However, the content of each topic is presented in the 
way you are most likely to use the application.

This topic includes information on:

• Adding the Help System to Your Favorites

• Accessing the Help System

• Finding Information

• Tips for Using the Help System

Adding the Help System to Your Favorites

You can add useful pages of the help system to Favorites in your web browser. 
This allows you to access these pages directly, even from outside the 
application.

STEPS

To add a page of the help system to Favorites:

1. Click Help to access the help system through the application.
2. Find an appropriate page to bookmark.
3. Right-click anywhere in the right pane and select Add to Favorites.
4. Accept the default contact name or type a new one.
5. Follow the instructions provided by Internet Explorer to add this 

bookmark to your list of Favorites. 
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Documentation Preface
Accessing the Help System

Select the easiest access method for you.

STEPS

To access the help system: 

1. Select a Company and click Go.
2. To access context-sensitive help, select the Help button from the 

header on any web page 
–or–
Select the F1 key (after making a selection on the page).

  Note:       For optimal viewing and printing of sample reports, use the User 
Reference PDF. 
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Preface Documentation
Finding Information

There are three different ways to locate information in the help system.

STEPS

To locate information in the help system, use the Index, Search or Contents 
tabs:

• Index:
Select the desired term or phase from the alphabetical listing.

• Search:
Type the word you want to find, and then click Go!

• Contents:
Select a topic to view from the list in the left pane. In most cases, your 
selection takes you directly to a procedure (STEPS) in the help system.

Tips for Using the Help System

Here are some tips for the best use of your help system:

• Browsing the Help System 

• Printing a Help System Topic

• Copying and Pasting Information

  Tips:   

• To find step-by-step instructions on a help page, look for the 
word STEPS.

• To find information on a help page about a field control, look 
for the words PAGE DESCRIPTION.
18
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Browsing the Help System

STEPS

To browse the help system:

Click the Back button on the browser toolbar to display the last topic viewed. 
Then click the up arrow button on the help system toolbar to step back 
sequentially through the topics
–or–
click the down arrow button on the help system toolbar to display the next 
topic in a series.

Printing a Help System Topic

STEPS

To print a help topic, display the topic and then:

Select the printer icon on the web browser toolbar
–or–
select File > Print
–or–
press Ctrl+P
–or–
right-click and select Print from the drop down list.

  Note:       When you reach either end of the series, only one button is 
active.

  Note:       You can print only one help system topic at a time. However, you 
can print as many topics as you want from the User Reference 
PDF. For detailed information, see Viewing PDF Documents.
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Copying and Pasting Information

STEPS

To copy and paste information from one document to another:

1. Select the text you want to copy and then select Edit > Copy or 
Ctrl+C (or Ctrl+Insert).

2. Place the cursor in your document and select Edit > Paste or Ctrl+V 
(or Shift+Insert).

PDF Documentation—User Reference and Release 
Notes

This topic includes information and instructions for PDF documentation:

• About PDF Documentation

• User Reference

• Release Notes

About PDF Documentation

This topic includes information and instructions for PDF documentation:

• Installing Adobe Acrobat Reader

• Accessing PDF Documents

• Viewing PDF Documents

• Tips for Using PDFs

• Document Structure

• Documentation Conventions
20
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Installing Adobe Acrobat Reader

You must install Adobe Acrobat Reader (AKA Reader)before you can view or 
print PDF documentation. For best results, we recommend version 7 or higher. 
You can download the software from the Adobe web site at: http://
www.adobe.com

Accessing PDF Documents

You can download the most up-to-date copy of the system’s User Reference, 
Release Notes, and other PDF documents from the  

STEPS

To access the PDF documentation from our website:

1. Log in to Solutions Central and click the Documentation tab. 
2. Click on Documentation Library to view the list of available PDF 

documents for download.

Viewing PDF Documents

This topic provides basic information for viewing PDF documents. For 
detailed information on using the features and functions of Reader, see the 
Reader’s help system. 

STEPS

To view a PDF document:

1. Save the PDF document to your PC.
2. In Windows Explorer, double-click on the document. This displays the 

document using Reader. 
3. Use the Table of Contents (bookmark list) to navigate through the 

document or use the What’s New bookmarks to view new and 
important information.

4. To review the information, print the document or scroll through the 
pages using the scroll bar on the right side of the page.
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Tips for Using PDFs

This topic provides basic tips for using PDF documents. For detailed 
information on using Reader features and functions, see the Reader help 
system. 

• To select all text (and no graphics) on the current page, choose Edit > 
Select All.

• Click on an embedded link shown in blue text within the document to 
access information on specific tasks.

• To quickly navigate throughout the document, expand and collapse the 
Bookmark list. This is especially helpful when viewing What’s New 
topics:

• To expand a topic (show subtopics), click on its plus symbol (+). 

• To collapse a topic (hide subtopics), click on its minus symbol (–).

• If the Reader toolbar does not appear, press the F8 key to display it.

• To search for a word or phrase in a PDF: From the Reader toolbar, click on 
the binoculars icon to begin a search. 

You can view PDF documents in three different layouts; this affects how some 
Reader functions work, and also affects links in the PDF document.

STEPS

To change the layout, choose View (or View > Page Layout) and one of the 
following selections:

• Single Page: Displays one page at a time. Select a link to access the 
referenced page.

• Continuous: Displays the pages in a continuous vertical column. Select a 
link to access the referenced topic at the top of the page.

• Continuous-Facing: Displays facing pages side by side, with odd pages 
on the right. Select a link to access the referenced topic at the top of the 
page.
22
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Document Structure

The information in this document is presented in the way you are most likely 
to use the application.

Our printable document saves you time whether you are using the software for 
the first time or are an experienced user. 

If you know the type of information you are looking for, you can scan the 
document quickly to find what you need:

• Overview: Read this information for a topic introduction.

• Steps: Read this information to perform a specific task. The Steps section 
serves as a procedural outline. Experienced users may not need to refer to 
the Introduction or Page Description sections.

• Page Description: Read this information when you need specific details in 
order to complete the Steps section. Links and cross references are used to 
avoid duplication of information. Experienced users may not need to read 
this entire section. 

 

Documentation Conventions

The following typographical conventions are used throughout the 
documentation to help you identify different types of information.

  Note:       Some PDFs are presented in double-sided format. Blank, 
numbered pages occasionally appear in these documents to 
preserve the double-sided layout.

Table 1: Documentation Conventions

Convention Description

Bold In procedural steps, the required selection 
(e.g., click OK).

Note: / Notes: Significant information.

Tip: / Tips: A hint that will help to make a step easier 
or more efficient.
User Reference 23



Preface Documentation
User Reference

The User Reference PDF contains conceptual information, detailed overviews, 
examples, definitions of terms, and workflow-related information. It is 
designed for quick online reference via links to various topics and can also be 
printed.

Important! Important information.

STEPS           Step-by-step procedures.

PAGE DESCRIPTION A list of field descriptions for a web page.

Ctrl+O
(keystroke combination)

Hold down the first key in the sequence 
while pressing the second key in the 
sequence.

Company > Agents Function and Subfunction selections, i.e., 
process link or navigation trail.

(required) A field that must contain data in order for 
the application to save the record. 

A field is considered optional if the term is 
not marked as (required) or (read-only). 

(read-only) A display-only field for which the 
information is generated by the application. 
You cannot edit a read-only field.

(information only) A field that functions like a comment for a 
record. Typically, information only fields 
display on reports.

Example: Street address and Email 
address information (the system does not 
use this information to process a record).

Table 1: Documentation Conventions

Convention Description
24
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Release Notes

The Release Notes PDF contains descriptions of new features, fixes, known 
issues, and other considerations that may affect your use of certain 
functionality in this release. 

Please review all of the information in the Release Notes before you begin 
using any of the products in this release.
 

  Notes:  

• For information on downloading this information, see 
Accessing PDF Documents.

• You must install Reader before you can view or print PDF 
documentation. For more information, see Installing Adobe 
Acrobat Reader.

• “What’s New” bookmarks are used to identify new features or 
important changes in the software described in the PDF. 
Select the bookmark to jump to the newly added or modified 
information in the PDF and to view summary details in a 
popup box. You must use Reader version 7 or higher to 
properly display these note boxes.

  Notes:  

• For detailed information on downloading Release Notes, see 
Accessing the  Documents.

• You must install Reader version 7 or higher before you can 
view or print PDF documentation. For detailed information, 
see Installing Adobe Acrobat Reader. 
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Available Services

To further assist you with this product,  offers a number of 
services. For details, see:

• Consulting Services 

• Technical Services 

• Educational Services

• Support Services 

For more information, visit our web site at:

Consulting Services

 
selection of operational and technical expertise.

Our experienced consultants can help you with: 

• System and application audits 

• Application and reporting changes

• Creation of new plans and grants 

• Upgrade assistance 

• Ad hoc report writing

• IPO assistance
26
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Technical Services

Technical Services group can help you solve any technical 
challenges you may encounter with our software.

Our technical services include:

• Data management 

• Technical consulting 

• Custom programming 

Educational Services

 
industry. Depending on your needs, you can choose from seminars over the 
Internet, classroom style learning, on-site training at your facility or 
customized classes designed exclusively for your company.

Offerings include:

• Hands-on product courses 

• Industry seminars

• Webinars 

• On-site training 

• Custom documentation
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Support Services

ervices team can help you with general product or 
technical questions. You can access Support  and our 
Find Answers system. Support responds to questions 9 a.m. to 8 p.m. ET, 
Monday through Friday (except U.S. holidays).

Services (all available via the  website) include:

• Find Answers: Use  of Frequently Asked 
Questions and issue responses to find an answer.

• Guide to Support Services: Read the Support Services Plan located on 
the Support tab of the Solutions Central web site.

• Support Request: Search the Solutions Central web site’s Find Answers 
knowledge base for answers to your questions, or use the site’s Find 
Answers function to “Ask a Question.”

• Product Updates: Obtain maintenance information by subscribing to a 
product update list. To subscribe, select the My Company tab on the 
Solutions Central website.

• New Releases: View what’s new in the latest release on the Support tab on 
Solutions Central.

• Client Profile Form: Submit an online form to notify  of 
any changes or additions to your company profile (use the Company tab).

• Documentation: Review, search or download documentation from the 
Documentation tab on Solutions Central.

Solutions Central

 the client-only section of the , 
offering you access to valuable resources, information, and support. You can 
network with other users, get answers to frequently-asked questions (FAQs), 
and keep informed of current product issues. You need a Client ID in order to 
access Solutions Central.
28
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STEPS

To obtain a Client ID:

1. Access the Solutions Central log in screen at: 

2. Select the Help Form hypertext link.
3. Select the New ID radio button.
4. Complete the following fields: Name, Company, Title / Department, 

Email, and Phone.
5. Click Submit Form to send your request. Access information is then 

emailed to you.

 

  Note:       For information on accessing documentation from 
Solutions Central, see Accessing PDF Documents on 
page 21.
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Feedback Forum

The Information Development team prides itself on quality, 
accuracy, and timeliness in providing complete information for a variety of 
products. In an effort to provide continuous improvement, we welcome your 
comments and suggestions at any time. Your input serves as another source of 
quality in our documentation production process.

Please use the following questions to evaluate our documentation and provide 
feedback, if necessary:

• Do you need more information for a particular subject area? If so, which 
one?

• Did the examples provided offer you enough information? If not, do you 
need more examples or should the given example be revised?

• With regard to procedures or instructional steps, were you able to execute 
functions with ease? If not, how would you improve the procedure?

• Did you find any errors in the documentation? If so, where?

• Was the information presented to you in a clear and concise manner?

• Were you able to find the information you needed?

To report an error or offer a suggestion on improving our documentation in 
any way, please send us an email or letter via fax. Indicate the title of the 
document and send your suggestion using one of the following methods:

 
information in your correspondence. For example, please provide your direct 
email address if you want to receive a reply via email.

If you a cal issues or problems with the software, please 
contact
30
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hapter 
             1 Before You Begin

Before you begin using the  application, you should review this 
information to familiarize yourself with how the software works.

• About the  Solution

• Screen Terminology

• Navigating the System

• Keyboard Tips

• Errors

Also, before moving on to the topics that require data entry, you should review 
the company plan documents and/or grant agreements. These documents 
contain the information needed to set up parameters used by the system.
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About the  Solution

 automates the administrative process of managing a stock option 
program within a global business environment by leveraging Internet 
architecture.

The following diagram illustrates the various groups that use P.

Figure 1:  P Overview 

 
plan administration for this type of environment by supporting these features:

• Ability to track location of international participants

• User-definable grant types, tax events, and codes

• Unlimited tax buckets

• Internationalized fields

Reporting Only Users

Internet

Plan AdministratorsBrokers

Web Self Service UsersCorporate Secretaries
Compliance Officers

Other 
Stakeholders

 
System 
Administrators
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About the  Solution Before You Begin
• Multiple currencies and stock classes

• Currency support for tax withholding 

• Exchange rates

• Processing of multiple corporations

• Global grant / participant modifications

• Audit history of user record modifications

• Use of multiple currencies

The  solution consists of the following:

• Application

•  Application

• Self Service Application

This chapter provides an introduction to the software applications and 
instructions on “getting around” in them.

TWP Application

The P application includes all the functions and subfunctions you need to 
effectively manage stock options in a global environment. 

  Important!  All new  users should review Screen Terminology.

  Important!  T uses roles and rights to restrict access to functions / 
subfunctions in the software. You will see only the 
subfunctions in the application that have been assigned to 
you by the Computershare System Administrator.
User Reference 33



Before You Begin About the
34

The e-Forms™ application is a Web-based system used to 
complete the U.S. Security and Exchange Commission's (SEC) Section 16 and 
Federal Deposit Insurance Corporation (FDIC) insiders’ filings. Transcentive 
e-Forms exchanges data easily with other applications, including 
Computershare’s Express Options, via import files.

Other benefits include:

• Generates files in proper formats for EDGAR® electronic filing and Web 
site ready posting.

• Saves IT cost and resources with hosted delivery and ensures data security.

• Provides a Print Preview mode to view SEC Forms 3, 4, and 5 and FDIC 
Forms F-7, F-8, and F-8A, for accuracy.

• Provides built-in Web-based reporting.

• Supports the SEC’s email notification feature, up to ten addresses.

Self Service Application

Self Service is a feature of . You use it to view your awards, shares, and 
exercises, while your plan administrator uses the system to maintain your 
company’s equity compensation plans. You can interact with your plan 
administrator through Self Service, and any changes entered in the system that 
affect you are automatically displayed in Self Service for you to view at your 
convenience. 

Benefits of using Self Service include:

• Self-service access for participants to personal portfolios, including grants, 
exercises, dispositions, and vesting schedules

• Advanced communication, including online grant agreements, exercise 
forms, and direct email to stock plan administrators

• Ability to model “what if” scenarios to see potential gain, costs, and taxes 
for various transactions

• Ability to analyze participants’ portfolio values at different share prices

• Participants can print statements and transaction reports (including grant 
history), plus view their portfolios visually using charts and graphs

• Ability to access documents tailored to the company’s stock plans
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Screen Terminology

This topic describes and illustrates the main elements of the application.

Figure 2:   Screen Elements 

Standard Page Terminology

 
Figure 3:  P—menu bar area

Table 1: Screen Element Descriptions

Term Description

close button Ends your application work session. Always click Submit to save changes before 
ending your session.

title bar Identifies the name of the product and browser.

menu bar In addition to the company name, date and time, the menu bar contains the 
following command buttons: Help, Close Company, Submit, Cancel, and Refresh. 
For more information on these command buttons, see the Standard Windows 
Command Buttons section.

scroll bar A colored, movable bar located to the right or bottom of the window, page, or dialog 
box when the page size exceeds the window size. Use the scroll bar to change the 
view of the page.

left pane Displays a list of data based on your navigation, previous selections, or Advanced 
Search in the workspace. From the list, you can select or exclude items as required 
by a process.

Example: Select Participants > Participant Maintenance and then select all 
participants in the left pane you want to delete.

When the list of items exceeds one page, the Search—Quick and Advanced—
function is activated in the left pane.

workspace Main area of the page on a PC display screen that presents information or requests 
input.
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Figure 4:  T orkspace area

 

Table 2: Menu Bar Terminology

Term Description

Select Function Dropdown list of main menu options that you can select to perform different 
tasks in the system.

Select Subfunction Dropdown list of sub-menu options based on the selected function.

View System Messages Displays a description of errors you may encounter (e.g., database write errors, 
invalid date errors). Example: When you have successfully saved data to the 
database, the following system message appears: Save Successful. 

A pop-up error message box appears when there is a critical error.

command button Use to implement specific commands for a page or series of pages.

HELP Click this link to access the product help system.

CLOSE COMPANY Click this link to return to the Choose a Company page. From the Choose a 
Company page, you can select a new company or click the Close button (  ) to 
exit the application. 

New Message Click this link to view one or more messages from the Computershare System 
Administrator. This link appears only when there is a new message. These 
messages are typically used to notify users of a scheduled server reboot or 
shut-down.

Messages are created and implemented by Computershare’s System 
Administrators.

Version No. Displays the TWP software version number. Select to display a Version History 
dialog box.

Table 3: TWP Workspace Terminology

Term Description

required field A field for which information is needed before you can proceed with a process. 

In TWP, required fields (or fields where user entry may or may not be required 
for every transaction or scenario) are marked with a pink dot ( ). Required 
fields, whether marked with a pink dot or not, acquire a pink background when 
left blank upon clicking Submit. You may also receive a system message.

Some required fields provide a default value or selection when that information 
has been entered in another part of the application, e.g., State and Country.
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field
(a.k.a. text box)

The area of a workspace in which you type to record data.

list box
(a.k.a. dropdown list)

A field that provides a list of possible choices indicated by a down arrow (i.e., 
dropdown list) or a list of data in columns for selection.

collapse / expand arrow A button on a section heading that you select to hide (collapse) and display 
(expand) workspace sections. Section Headings are gray when collapsed and 
blue when expanded.

navigation trail Hypertext links back to previous pages where you made a selection in the left 
pane. The navigation trail is located in the workspace area.

As you perform a process in TWP, each page completed becomes part of this 
hyperlink so that you can backtrack through a process.

read-only field A display-only field for which the information is generated by the application. 
You cannot edit a read-only field.

Table 3:  Workspace Terminology

Term Description
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